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Objectives 

Conventions 

About This Course 

How to Use DECwindows is a one-day lecture/lab course designed 
for users who are encountering a D ECwindows system for the first 
time. The course covers the basic skills required to work within the 
DECwindows environment. 

In this course you learn how to: 

• Manipulate DECwindows. 

• Start and use DECwindow applications. 

• Manage files. 

This guide uses the conventions described in the following table: 

Convention 

I Return I 
lctrtl@] 

Description 

Text within a box identifies a key, such as IReturnl. 

For sequences that use the lctril key, hold down lctrtl 
and press the second key. 

vii 



viii About This Course 

References 
The following documentation provides additional information on the 
topics covered in this course. 

• Overview of VMS DECwindows (Order Number: AA-MG17A-TE) 

• VMS DECwindows User's Guide (Order Number: AA-MG18A-TE) 

• VMS DECwindows Desktop Applications Guide (Order Number: 
AA-MG19A-TE) 



Objectives In this module you learn how to: 

• Start a DECwindows session. 

• Manipulate windows. 

• Choose menu items. 

• Use a dialog box. 

• Quit a DECwindows session. 

1 
Getting Started 

1-1 
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Starting a DECwindows Session 
You enter DECwindows by starting a session. To start a session, you 
enter login information (your Usemame and Password) in the Start 
Session dialog box. 

DECwindows displays a dialog box whenever information is needed 
from the user. 

StartS...lon 

Usenwn•~IJ _________ ___ 
Password ..._ __________ _ 

II OK II I a.. I 
C Dlgltal Equipment Corporation. 1988. 

All Rights Reeerved 

Figure 1-1 Start Session dialog box 

Steps to Start a DECwindows Session 

1. At the Usemame prompt, enter your usemame and press IReturnl. 

The I Delete I key is used to erase mistakes. 

The OK push button has a double border. The double border 
indicates that you can either press I Return I or click on the button using 
the mouse to activate. 

2. At the Password prompt, enter your password and press I Return I. 

DECwindows displays a wristwatch whenever it is busy and you must 
wait. In this case, the system is verifying the Usemame and Password 
combination. 

If incorrect information is entered, DECwindows does not let you start a 
session. Instead, it displays a Problem Report dialog box as a warning 
that you have made a mistake. You must press IReturnl or click on the 
Acknowledged button to try again. 
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r Push-t~Back Bunon 

~------------------------------~--------------~,G!j~,_...fj]JI,......,...,.,,, 
._____,,·:.::HUBBUB I lt'GwOAOO(JONESJI . 

T111eBar---­

Shrink-to 
~on:...__/flim"--;;.;..;;..;;.;.;;~w:-~~.+n;~;;..;;;.~;;;,;..;;;.;:..;;.~.;.;;.;,;;.;...;;...;.;.:;;;.;;.;.;~~.;;.;;.;~.;.,;.;.;;..,;.;..;~~~-----He-l~p~~ 

Last Ale Alter: I Last i.:.._ _______________________ ~ 

Starting Dlrectory:j'-W_O_R_K.:..::.·[J_O_N_ES_..;:ill..__ _________________ _ 

I Appty I 0 L ~one J r!~~~';!~ ~7 
0 [.MAIL) 

[.SCHEDULES) 
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CURRENCY :-TXT 
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PRODOCTION.DIS 
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Ra-1E CONTACTS .LIS 
SALES PLAN .PS 
TAADE - BAARIEP.S. TXT 

Figure 1-2 DECwlndows Initial screen display 
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Manipulating Windows 

Using the Mouse 

In the DECwindows environment, all applications are based on the same 
user interface. Therefore the applications have the same appearance. For 
example, window components such as the title bar appear in the same 
location in every window. This consistency makes it easy to work with 
and learn applications running in multiple windows. Once you have 
learned to work in one window, you can work in any window. 

Working with DECwindows applications is like working at a desk. At a 
desk, you can do several tasks at once. In DECwindows, you can have 
multiple windows open, and in each window you can perform a different 
task. 

To manipulate windows you use the mouse. The mouse is the standard 
input device for DECwindows. (For most computers, the keyboard is the 
standard input device.) 

Figure 1-3 Mouse 
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• The standard mouse has three buttons. 

• The left-most button is referred to as mouse button 1 MBl, the 
middle button is MB2 and the right button is MB3. 

Giving Input Focus 

The table below shows how to work with the mouse. 

Action 

Click 

Double-Click 

Drag 

Description 

Place the pointer on the object. Then press and 
release MB 1. 

Place the pointer on an object. Then press and 
release the mouse button twice in quick succession 
without moving the pointing device. 

To drag the pointer, first place the pointer on an 
object. Press and hold the mouse button and move 
the mouse. Release the mouse button when the 
pointer is at the desired location. 

Each pointer shape has a "hot spot," a single point within the shape 
that determines precisely where you are pointing. The tip of the 
arrow shape is the "hot spot." 

In windowing systems, such as DECwindows workstations, keyboard 
input only appears in one window at a time. The window that displays 
the keyboard input is the active window. It has input focus. When a 
window has input focus, its title bar is highlighted. 

Steps to Give Input Focus 

1. Point to the FileView's title bar. Avoid pointing to the buttons at 
either end. 

2. Press and quickly release MBl. 

This technique is called clicking. 

3. Repeat the steps to give input focus to the Session Manager window. 

The title bar of the window with input focus is highlighted, indicating 
the window is active. 
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Shrinking Windows to Icons 

When an application is running, it displays either as a window or as 
an icon. If you are not using a· window but you want to keep the 
application running, store or shrink the window as an icon. 

Shrinking windows to icons reduces visual distraction and lets you 
concentrate on the tasks in the displayed windows. 

Steps to Shrink a Window into an Icon 

1. Point to the Shrink-to-icon button. 

2. Click MBl. 

The window disappears from the screen and its icon becomes 
highlighted in the Icon box. 

Steps to Redisplay a Window Stored as an Icon 

1. Point to the appropriate icon. 

2. Click MBl. 

Note the following: 
• The icon is no longer highlighted in the Icon box. 
• The window appears at its original screen location. 
• The window has input focus. 
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You can move any window with a title bar to any position on the screen. 
You can also move windows partially off the screen. You do this with a 
technique cal.led dragging. 

To drag, press and hold MB 1, then move the pointer. Release MB 1 
when the pointer is at the desired location~ 

You move a window to: 

• Reduce pointer movement between windows. 

• Arrange your screen in a more efficient manner. 

• Prevent a window from being covered up by moving it to a less 
cluttered portion of the screen. 

• View contents of windows simultaneously. 

• Edit between windows. 

Steps to Move a Window 

1. Point to the title bar. (Avoid pointing to the buttons on either end of 
the title bar.) 

2. Drag the window to its new screen position. 

Note: As you drag the mouse, an outline appears. 

3. Release MBl when the window outline is at the desired location. 

Note that windows cannot be moved off the screen entirely. Moving 
them partially off the screen offers another way to reduce screen clutter. 
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Changing the Size of a Window 

You change the size of a window with the Resize button. Making a 
window smaller leaves more room for other windows. Enlarging a 
window may display more of the window contents. 

Steps to Resize a Window 

1. Point to the Resize button. 

2. Drag outside the current boundary of the window. 

Note: An outline of the window displays. 

3. Release MBl when the window is the size you want. 

Note: To make a window smaller, drag the Resize button outside the 
current boundary of the window. Then drag to the left and downward 
until the outline is the size you want. 
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Stacking Windows 

The workstation screen can contain overlapping windows, much like 
a stack of papers on a desk. Overlapping windows are called stacked 
windows. With a stack of papers, you can shuffle the order to bring 
hidden papers to the top of the stack. In DECwindows, you use the 
Push-to-back button to move the top window to the bottom of the stack. 

Steps to Push the Top Window to the Back 

1. Point to the top windows 's Push-to-back button. 

2. Click MBl. 

The top window is pushed to the bottom of the stack; the window 
under the top window becomes the top window. 

3. Click on the Push-to-back button of the top window until you 
uncover the window you want. 

Steps to Display a Particular Window 

1. Point anywhere in the window. 

Note: Avoid the Shrink-to-icon, Resize, and Push-to-back buttons. 

2. Click MBl. 
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Selecting Menu Items 
One way to work with DECwindows is to choose. an item from a menu. 
The most common DECwindows menu is the Pull-down menu. Pull­
down menus get their name because you "pull them down" from the 
menu bar. 

Viewing Menu Items 

Steps to View Menu Items 

1. Position the pointer on the appropriate menu in the menu bar. 

2. Press and hold MBl. 

A menu drops down automatically. 

3. Move the pointer outside of the menu and release MBl. 

The menu disappears and no action is taken. 

Selecting a Menu Item 

By selecting a menu item, you tell DECwindows what you want to do. 

Steps to Select a Menu Item 

1. Position the pointer on the appropriate menu in the menu bar. 

2. Drag the pointer downward. 

3. Release MBl when the appropriate menu item is outlined. 
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Scroll bars allow you to move through a display that does not fit in a 
window. They scroll your window up or down over the text or data. 

The parts of a scroll bar: 

• The stepping arrows on either end of .the bar move you through text 
one line at a time. 

• The scroll region is a long, thin box. 

• The slider, the thicker box that overlays the scroll region, indicates 
your position in the text or display. 

Slider size is relative to the total amount of information. 

The table below describes how to use scroll bars. 

To scroll 

One line at a time 

Forward one 
window-full of text 
at a time 

Back one window­
full of text at a 
time 

To another location 
in the list or file 

Do this 

Click MB 1 on the stepping arrows at either end of the 
scroll bar. To scroll continuously, press and hold MB 1 
on the stepping arrow. 

Point to the scroll region beneath the slider and click 
MBl. 

Point to the scroll region above the slider and click 
MBl. 

Drag the slider to a position in the scroll region that 
corresponds to the general location you want to see. 
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Using Dialog Boxes 
Dialog boxes are special DECwindow windows. Some dialog boxes 
display options. Other dialog boxes allow you to enter additional data 
in response to some commands. Some appear automatically such as the 
Start Session dialog box; others are displayed when you select a menu 
item followed by three periods (an ellipsis). 

Customize Poit1ter 

Pointer Acceleration 

()None 

()Slow 

() l\•1edium 

i.i:• Fast 

Pointer Foreground Color 

Buttor1 Arrangement 
1:i:1 Right Handed 
(:_) Left Handed 

r\•1ouse Double Click Timeout 

250 

Milliseconds 

OK II Apply I 

Figure 1-4 Customize Pointer dialog box 

1:~:1 Black Or1 White 

() White On Black 

Pointer Shape 

~~ 

+ 

6 
,......, 

•o 
Cancel I 
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Selecting Dialog Box Options 

Each dialog box has options related to the menu with which it is 
associated. 

Dialog boxes supply various ways for you to enter information. 

You can: 

• Click a round option button or a square toggle button. When a 
button is highlighted, the setting is on. 

• Drag the slider in a scale until the arrow in the slider points to the 
value you want. 

• Select choices from a list box. 

• Enter text in a text entry field. 

Methods to Activate the Dialog Box Settings 

• Click on either the OK or Apply buttons to activate the settings you 
have chosen. 

When you click OK, you clear the dialog box from the screen. 

When you click on Apply, the dialog box remains on the screen. 

• Click on Cancel to clear the dialog box from the screen. 

This setting will put away the dialog box without affecting changes 
made previously. 
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Ending a DECwindows Session 
Whenever you are not using your workstation you should either pause or 
quit your session to prevent someone else from accessing your account. 

Pausing a DECwindows Session 

Pausing is placing your system on hold. Your session and the 
applications continue to run. 

Steps to Pause a DECwindows Session 

1. If the Session Manager window is stored as an icon, redisplay the 
window. 

2. Point to the Session menu. 

3. Click on Pause. 

The entire workstation is locked by the Pause session display and 
dialog box. 

4. Type your password and press IReturnl to resume the session. 

Quitting a DECwindows Session 

Before you quit DECwindows, you should close any open files and stop 
all applications. 

Steps to Quit a DECwindows Session 

1. If the Session Manager window is stored as an icon, redisplay the 
window. 

2. From the Session menu, choose Quit. 

A Confirmation dialog box appears. 

3. Click on Yes to end your session. (Click on No if you want to 
continue your current session.) 

The Start Session Dialog box displays. 



Review 
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Review the topics covered in this module: 

• You start a DECwindows session by logging in at the Start Session 
dialog box. 

• You can move, resize, stack, and shrink-to-icon all windows. In 
DECwindows, the information you enter through the keyboard or 
mouse is directed to one window at a ti.me. A window that is ready 
to receive the information has "input focus." 

• Most functions of an application are found in pull-down menus. You 
select these functions by choosing a menu item. 

• Menu items followed by an ellipsis ( ... ) will display a dialog box. A 
dialog box is a special window which allows users to select options 
or enter additional information. 

• Pausing a session freezes the workstation display while allowing all 
applications to continue. Quitting a session stops all applications and 
ends the DECwindows session. 
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Exercise: Working with Windows 

1. Start a DECwindows session. 

2. Shrink all windows to icons. 

3. Display all windows stored as icons. 

4. Select a different pointer shape. 

5. Resize the Session Manager window to make it as large as the 
File View window. 

6. Pause your DECwindows session. 



Answer 
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1. To start a DECwindows session, enter your Usemame and Password 
in the Start Session dialog box. 

2. To shrink a window, click on the Shrink-to-icon button in the upper 
left comer of the title bar. 

3. To display a window, click on its icon in the Icon box. 

4. To select a different pointer shape: 

a. From the Session Manager menu bar, pull down Customize 
menu. 

b. Click on Pointer. 

c. Scroll through the list of pointer shapes. 

d. Click on the pointer shape of your choice. 

e. Click on OK. 

5. To change the size of the Session Manager window: 

• Point to to the Resize button. 

• Press and hold MBl and move the pointer to the right and 
upward until it is outside of the window. 

• Release MBl when the Session Manager window is as large as 
the File View window. 

6. To pause a session, from the Session menu, click on Pause. 





Objectives In this module you learn how to: 

• Start Notepad. 

• Enter text in Notepad. 

• Save a Notepad file. 

• Work with Notepad. 

• Edit a Notepad file. 

• Exit Notepad. 

2 
Notepad 

2-1 
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Starting Notepad 
You will learn a Desktop application called Notepad. Notepad is a 
simple, easy-to-use editor. It is intended for everyday tasks, such as 
jotting down notes. You might use Notepad to make a To Do list or to 
keep track of the day's events. Later, you could incorporate the notes 
into a status report. 

All commands are located in the pull-down menus, so you do not have 
to memorize commands. All the desktop applications begin and end the 
same way. You start an application from the Applications menu in the 
File View window. To leave applications, you either exit or quit. 

Steps to Start Notepad 
' ,,.. ·- -

1. If File View is, stored as an icon, redisplay as a window. 

2. Point to FileView's Application menu and press MBl. 

3. Drag the pointer through the pull-down menu items. 

4. When you have outlined Notepad, release MBl. 

A Work in Progress dialog box appears to let you know that Notepad 
is starting. Then Notepad displays an empty window. 

FileView - Wot·k ir1 Pt·ogt·ess 

Work in Pt·ogt·ess Files Status 
i'.t 
~ Clock Active 

Note ad 1/1 Active 

-0 
, ............................................... . 
j ·~;~).;'~'><.> {"::~:·~:'0<d· ~ l .. ,,i ... :· n ······ -.<.'\~d<-. I 

)$~~~~· • ~::: 

Stop Task I 

Figure 2-1 Work In Progress dialog box 

Dismiss I 
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Entering Text in Notepad 
The Notepad enters text at the position marked by the text insertion 
cursor and wraps it automatically to the next line. 

~~;.:1 Notepad: Unt:it:lcd 

Fiie Edit: Sea1·ch Navigate c.ust:onlize Help 

Figure 2-2 Notepad window 
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Typing and Formatting Text 

Practice Text 

Here are some guidelines for entering text in Notepad: 

• Click· on the Notepad window to establish input focus. 

• Text automatically wraps at the right margin. 

• Use I Delete I to erase mistakes to the left of the cursor. 

• Use ITabl, lspace Bari, and !Return! to arrange text. 

• Resize the window to change the position of the right margin. 

To Do: Monday 

Call Darlene about technical resources. 

Call John about illustrations. 

Plan agenda for staff meeting. 

Complete expense report. 
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Saving a Notepad File 
Notepad offers two options for saving a new file, Save and Save As. 
Both options create a copy of the most recent version of a file in your 
directory without removing it from the screen. 

If you are saving a file for the first time, both options provide a dialog 
box to enter a file name. 

Once the file has been saved, use Save to incorporate updates to it; use 
Save As to save an existing file under a new name. 

Steps to Save a Notepad File 

1. From the File Menu, choose Save As. 

A dialog box displays. 

2. Type the name of the file in the Save As dialog box. 

3. Click on OK. 

Save As •.• 

Sa\•e As II 
II OK 11 I Cancel I 

Figure 2-3 Save As dialog box 
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Working with Notepad 
You need to learn how to move cursor within a Notepad file and how to 
select and deselect text. These skills are fundamental tasks in this or any 
editor. 

Moving the Cursor 

To change the contents of the Notepad, you first move the cursor to 
the point where the change is to be made. The cursor can be moved in 
several ways. 

Steps to Move the Cursor 

1. Point to the place in the file where you want to move the cursor and 
click MBl. 

The insertion point changes to that location. 

2. Use the right and left Arrow keys to move the text cursor one 
character to the right or left. 

3. Use the up and down Arrow keys to move the text cursor one line 
up or down. 

4. Press ml to move the cursor to the beginning of a line. 

5. Press lShittlF12I to move the cursor to the end of a line. 

6. From the Navigate menu, choose Go to Top or Go to Bottom. 



Selecting Text 
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You must select text before performing editing tasks on it. Selected text 
is highlighted, a visual indication that the editing task will be performed 
on the selected text. 

There are two techniques for selecting text: mouse clicking or mouse 
dragging. 

You use mouse clicking to select a unit of text, such as a word or a line. 
Use mouse dragging to select a range of text, such as a portion of a line, 
paragraph, or page. 

Steps to Select Text by Mouse Clicking 

1. Point to the word you want to select and double click. 

The word is highlighted. 

2. Point to the line line you want to select and click MBl three times. 

The line is highlighted. 

Note that only one set of text can be selected at a time. 

Selecting a Range of Text 

To perform editing tasks such as deleting, moving, or copying text, you 
must first select the text you want to edit. 

Steps to Select a Range of Text 

1. Click MBl in front of first word you want to select. 

2. Drag past the last word you want to select. 

Steps to Extend the Current Selection Range 

1. Position the pointer where you want the selection range to end. 

2. Press IShittl and click MBl. 
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Deselecting Text 

You may need to deselect text. 

Steps to Deselect Text 

1. Point to any portion of the selected text. 

2 .. Click MBl. 

The text is no longer highlighted or selected. 

Opening a Second Notepad Window 

You may want to refer to and copy information from one Notepad 
window to another. 

Steps to Start a Second Notepad window without Closing the First Window 

1. ·From the File menu, choose New. 

A second untitled Notepad window opens directly over the first 
Notepad window. 

2. Drag the second window aside so that both Notepad windows are 
visible. 
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Editing a Notepad File 

Copying Text Between Windows 

Most DECwindows applications, including Calendar, Cardfiler, EVE, 
FileView, Mail, and Notepad, allow you to move or copy text: 

• From one place in a window to another. 

• From one window to another window. 

• From one application to another. 

To move or copy text, you must select the text first, then choose one of 
two commands in the Edit menu, Copy or Cut. Both commands copy 
the selected text to the Clipboard, a special temporary holding area for 
cut or copied text. 

• The Copy command copies selected text without removing it from 
the file. 

• The Cut command copies selected text then removes it from the file. 

Steps to Copy Information between Windows 

1. Select the text to be copied. 

2. From the Edit menu, choose Copy. 

The text remains in the original location and a copy of it is placed in 
the Clipboard. 

3. Position the cursor in the other window at the po~t where you want 
to insert the copied text. 

4. Click MBl to set input focus. 

5. From the Edit menu of the window with input focus, choose Paste. 

The copied text appears at the desired location. 
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Deleting Text 

Canceling Edits 

There are several ways to delete text: 

• To remove a word to the left of the cursor, press I F13 L 

• To remove the word to the right of the cursor, press IShittl IF13L 

• To remove a larger amount of text, use the Cut or Copy commands 
from the Edit menu. 

• To replace text in one operation without using the Cut or Copy 
commands, select the text you want to clear and type the new text. 
The new text replaces the selected text. This is called Pending 
Delete. 

There are two ways to recover from mistakes: 

• The Undo command in the Edit menu cancels the last edit provided 
you choose the command immediately. 

• The Revert command in the File allows you to recall the last saved 
version of the file. 

Steps to Use the Revert Command 

1. From the File menu, choose Revert. 

A Dialog box appears asking if you want to save changes to the 
current file. 

2. Click on No. 

The contents of the file returns to the screen. 



Practice Text 

To Do: Tuesday 

Arrange meeting with technical reviewers. 

Print illustrations. 

Write status report. 

Write John's performance review. 

Prepare overheads for staff meeting. 
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Using Quick Copy 

Quick Copy is a fast method for copying text. Using Quick Copy 
you can copy text without pulling down menus and choosing Cut or 
Copy and Paste. The method works within a single window as well 
as between windows, including copying text between windows of two 
different applications. 

Steps to Quick Copy 

1. Set input focus on the window to receive the text. 

2. Position the cursor where the text is to be inserted. 

3. Point to the text to be copied. 

4. Drag MB3 over the text to be copied. 

Note: The text is underlined. 

5. Release MB3. 

The text is copied to the window with input focus. 
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Practice Text 

Status Report 

Identified and met with three technical resources. 

Requested, received, printed and reviewed illustrations. 

Planned agenda and overheads for staff meeting. 

Wrote John's performance review. 
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Exiting from Notepad 
Every application takes up memory. When you shrink an application into 
. an icon, the application continues to use the same amount of memory. 

As you open new windows and assorted applications, each window uses 
additional memory. As a result, performance may suffer. Therefore, 
when you are finished with an application; exit from it. 

The Exit ·Or Quit menu items for most applications appear in the 
left-most pull-down menu. 

Steps to Exit from Notepad 

1. Save any work. 

2. From the File menu, choose Exit. 
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Review 
Review the topics covered in this module: 

• Standard Desktop applications, such as Notepad, are started from the 
Applications menu in. the File View window. 

• The Notepad is intended for everyday writing tasks. You can type 
text from the keyboard or copy existing text for editing. 

• To save the contents of a file, use one of two commands: Save and 
Save As. Use Save As to name a new file or to save an existing file 
under a new name. Use Save to update changes to an existing file. 

• You edit Notepad files by using both the mouse and the keyboard. 

• Most editing tasks require you to move the cursor and select the text. 
Selection is done by clicking or dragging the mouse. 

• When you finish using a DECwindows application, end the 
application by using the Exit command. 



Exercise: Starting Desktop Applications 

1. Start the Clock. 

2. Start the Calculator. 
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3. Use the Calculator to figure out the mileage reimbursement for a trip 
of 60 miles. The reimbursement rate is .225 cents per mile. 

4. Use the Help function in Calculator (Performing Arithmetic 
Functions, Copying Numbers to Other Applications) to find out 
how to copy the results of your calculation to an application running 
in another window. 

5. Start Notepad. 

6. Copy the result of your calculation into the Notepad window. 

7. Create the following text in a Notepad file. Save the contents as 
ToDo Wednesday.TX.T. 

To Do: Wednesday 

Distribute agenda for staff meeting. 

Submit Mileage Reimbursement for (insert amount pasted from the 
calculator). 

8. Close Calculator. 

9. Close Notepad. 

Leave the clock running. 
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Answer 

1. From the Applications menu in File View window, click on Clock. 

2. From the Applications menu in FileView window, click on 
Calculator. 

3. Enter data by moving the pointer to a· button in the Calculator 
display and clicking MBl or by typing at the keyboard. If you type 
at the keyboard, you can use the number keys on the keyboard or the 
number keys on the keypad. 

Perform arithmetic functions on the Calculator just as you would on 
a hand.held calculator: 

a. Enter the first operand, 60. It appears in the accumulator. 

b. Enter the function you want to perform, multiplication, 
represented by an asterisk (*). The functions are addition (+), 
subtraction (-), multiplication ( * ), and division ({). 

c. Enter the second operand, .225. It appears in the accumulator. 

d. Enter the equal sign ( = ). The result, 13 .5, appears in the 
accumulator. 

4. To copy a number from the Calculator's accumulator or memory: 

a. Click on either the accumulator or memory to highlight the 
number. 

b. Choose Copy from the Edit menu to copy the highlighted 
number. 

5. From the Applications menu in FileView window, click on Notepad. 

6. To copy the result of your calculation into the Notepad window, set 
input focus on Notepad. From the Edit menu, choose Paste. 
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7. Create the following text in a Notepad file. Save ·the contents as 
ToDo _ Wednesday.TX.T. 

To Do: Wednesday 

Distribute agenda for staff meeting. 

Submit Mileage Reimbursement for (paste amount copied from the 
calculator). · 

8. To close Calculator, from the File menu choose Quit. 

9. To close Notepad, from the File menu choose Exit. 





Objectives In this module you learn how to: 

• Start the File View application. 

• List files and subsets of files. 

• Display files. 

• Maintain files. 

• Create a subdirectory. 

• Navigate the directory structure. 

3 
File View 

3-1 
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Starting FileView 
File View is an important window for two reasons: 

• It allows you to access DECwindows applications. 

Note that when you quit FileView, you also quit any applications 
started from File View. 

• It provides commands to work with your files. 

By default, a FileView window opens at the start of a DECwindows 
session. If you exit the FileView window, or if for some reason a 
File View window does not start automatically, you can create a File View 
window without restarting DECwindows. 

LilJl FileView - DEVICE:[USER] Ib!Jlfil 
Contt·ol Customize Views Files Utilities Applications Help 

File Filter: I 

Dit·ectory: ~ DEVICE:[USER] 

II Apply II~ I None I Sele~ted: 
Total Files: 42 

6 [. PRS] AlCOPY.DOC /·· .. 
'\..J 

.- .-
ACME_GUIDE.DOC 
Aln.JUAL_MEETIHG. DOC 
AlD-lUAL_MEETIHG_REPORT. DOC 
BOOKS. IMG 
BOOKS.PS 
BUDGET_MEETIHG.DOC .--

BUDGET_MEETIHG_REPORT.DOC 
COSTS_AHALYSIS.DOC 
COST_REPORT.DOC 
DECH$MA.IL.DA.T 
DECH$SM.LOG 
DEClUIIDOl'JS_OVERVIElf. DOC 
DISTRICTS.DOC 

'- FIGURESTEST.DOC ........ 

0 FIGURESTEST.PS 0 

Figure 3-1 FlleView window 
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Steps to Create a File View Window 

From the Session Manager's Create menu, choose File View Window. 

The File View window opens. 
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Listing Files 
File View provides a variety of ways for listing files in your account. 
When you first start DECwindows, the file list displays the files 
alphabetically in the top level directory. You can change the file listing 
to display more information. 

Steps to View all Files in your Directory 

1. From the Views menu, choose one of the Show: commands. 

Using the File Filter 

The File Filter lets you list a subset of files. By using the File Filter and 
a wild card, you can limit the display of files. 

The asterisk is a wild card. It can represent all or part of a directory 
name, file name, and file type, as well as the entire version number. 

Steps to View a Partial Listing of Files 

1. In the File Filter field, enter the file information. 

Examples: 

TO* 

*.TXT 

*·* 
2. Click on Apply. 



FileView 3-5 

Displaying Files 

Selecting Files 

In addition to listing your files File View provides two commands which 
allow you to see the contents of a file: 'fype and Print. 

The most efficient way to use these commands is to select the file you 
want work on first before selecting the command. If a file is not selected 
before choosing a File View command, File View will display a dialog 
box that requests the file name(s) on which to perform the command. 

Steps to Select One File 

1. Point to the file you want to select. 

2. Click MBl. 

The file name is highlighted. 

Steps to Select a Block of Adjacent Files 

1. Point to the first file in the block. 

2. Drag the pointer until all the files you want to select are highlighted. 

3. Release MBl. 

The block of files is highlighted. 

Steps to Select Scattered Files 

1. Point to the the first file you want to select. 

2. Click MBl. 

3. Press lshiftl and click MBl on every other file you want to select. 

Steps to Select All Files 

4. Click on All. 

All files are selected at once. 
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Canceling File Selection 

You can cancel file selection in two ways: 

Steps to Cancel File Selection 

1. To deselect individual files, point to each file you want to deselect, 
press lshittl and click MBl. 

2. To cancel the selection of all files, click None. 

The files are no longer highlighted~ 

Viewing the Contents of a File 

To see the contents of a file without making any changes to it use the 
Type command. 

Note that the Type command is located in two places: on the Files menu 
and from a pop-up menu. 

DECwindows provides pop-up menus to make it easier for you to work 
with files and applications. Pop-up menus give you quick and direct 
access to functions within applications by reducing your use of the 
mouse. 

Note that to view a pop-up menu in File View position the mouse cursor 
on the work area directly beneath the menu bar and press MB2. 

FileView -Type 

Files: 

D By Page 

Figure 3-2 Type dlalog box 

D Hide This Dialog 

\ Cancel I 
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Steps to View a File 

1. Select the file to be viewed. 

2. From the pop-up menu, choose 'fype. 

File View displays a dialog box from which you can select options to 
tailor the operation you have chosen from the Files menu. 

3. Click on OK. 

A Task Output window opens and displays the contents of both 
files. 

• If there is more than one page, press IReturnl to display the 
following page. 

• If you have chosen more than one file, press lcTRLI ~to cancel 
the display of one file and continue with the next file. 

• The word "Done" appears at the upper right-hand comer of the 
Task Output window when the the task has been completed. 

4. Click on Dismiss. 

The Task Output window closes. 
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Printing a File 

You can print a file by using the Print command from the Files or 
pop-up menus. File View sends the file to a print queue, where it is 
entered as a job to be printed. Once a file has been queued for printing, 
messages appear in the Session Manager window showing that the file 
has been queued for printing, that the job is completed, and if there are 
any error messages. 

FileView - Pt·int 

Files: 

Ii Show Queue Options D Hide This Dialog 

Figure 3-3 Print dialog box 
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Steps to Print a File 

1. Select the file you want to print. 

2. From the Files menu, choose Print. 

The Print dialog box displays. 

3. Click on Show Queue. 

Two listings appear: Print Formats and Printers. 

• File View displays all print formats supported by DECwindows, 
no matter what the file type of the file you selected for printing. 
Other applications, such as Paint, only show the print format of 
the file you have produced and want to print. 

• You must know which printer listed in the Printer dialog box will 
support the print format of the file you are trying to print. You 
get this information from the system manager. 

4. Choose the appropriate format and printer. 
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Maintaining Files 

Copying Files 

File maintenance is an important task for each computer user. 
DECwindows provides several commands for managing files. 

With DECwindows you can copy a file to a new file name or to a new 
directory. You can also combine two or more files into a single file. 
When you copy a file, the original file remains unchanged. 

FileView - Copy 

From: 

To: 

D Show Log 

D Request Confirmation 

OK 

Figure 3-4 Copy dialog box 

D Concatenate Input Files 

D Replace Existing Files 

D Hide This Dialog 

I Cancel I 
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Steps to Copy a File 

1. Select the file you want to copy. 

2. From the Files menu, choose Copy. 

The Copy dialog box displays. 

3. Type the name of the file to receive the copy in the To field. 

4. Click on Show Log. 

5. Click on OK. 

A Task Output window opens and displays the result of the copy 
operation. 

6. Click on Dismiss. 

The Task Output window closes. 
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Deleting Files 

When you no longer need a file, delete it. By deleting unnecessary files, 
you make room on your disk for other files. 

FileView - Delete 

Files: 

D Show Log D Et·ase Stot·age 
D Hide This Dialog D Request Confim1ation 

Figure 3-5 Delete dialog box 

Steps to Delete a File 

I Cancel I 

1. Select the file or files you want to delete. 

2. From the Files menu, choose Delete. 

A dialog box displays. 

3. Click on the appropriate settings. 

4. Click on OK. 

5. Click on Update. 

The directory listing is refreshed. 
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Purging Files 

Every time you modify a file you acquire a new version of it. These 
versions take up a great . deal of space on your disk. You can delete 
all older versions of files by using the Purge command. Purging your 
directory makes room on your disk for other files. 

FileView - Purge 

Files: 

li1 Show Log 

D Request Confirmation 

1 

Keep Versions 

Figure 3-6 Purge dlalog box 

Steps to Purge All Files 

D Et·ase Stot·age 

D Hide This Dialog 

1. From the Views menu, choose Startup. 

2. From the Views menu, choose Show: All Versions. 

3. Click on All. 

4. From the Files menu, choose Purge. 

5. Change the appropriate settings. 

6. Click on OK. 

7. Click on Update. 
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Creating a Subdirectory 
In DECwindows, you have the option of creating additional work areas, 
called subdirectories, under your top level directory. Subdirectories 
are useful for storing and retrieving files related to a given topic. By 
grouping related files, you save time in locating and accessing files. 

You can create up to seven tiers of subdirectories below your top level 
directory. The number of directories you have on each level is limited · 
by the amount of disk space you have available. 

I 
[USER.TO DO] 

TODO_MONDAY.TXT;1 

TODO_TUESDAY.TXT;1 

TODO_WED.TXT;1 

Figure 3-7 Directory structure 

[USER] 

LOGIN.COM 

STATUS.DIR;1 

TODO.DIR;1 

l 
[USER.STATUS] 

STATUS.TXT;1 
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Steps to Create a Directory 

1. From the Utilities menu, choose Create Directory. 

2. In the Create Directory dialog box, type the name of the new 
directory. 

3. Click on OK. 

Directories are a special type of file which: 

• Have a file type of .DIR. 

• Do not contain text. 

• Act as a pointer to subdirectories. 

• Cannot be edited. 

• Have a version number of 1. 

Create Directory 

Directory: 

OK 

Figure 3-8 Create Directory dlalog box 
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Navigating the Directory Structure 
When there are subdirectories in a DECwindows account FileView 
displays the names of the subdirectories in the Navigation List. Use the 
Navigation List to move up and down (navigate) the directory structure. 

Steps to Navigate the Directory Structure 

1. Click on name of the directory in the Navigation List view the 
contents of a directory. 

2. Click on the hyphen wild card to move up the directory structure one 
level. 

Copying Files To a Subdirectory 

You can copy a file to a subdirectory. The original file remains in its 
original location; a copy of it is placed in the subdirectory. 

Steps to Copy Files into a Subdirectory 

1. Select the file or files to be copied. 

2. From the Files menu, choose Copy. 

3. In the Copy dialog box, in the To field, click MBl immediately after 
the directory name. 

4. Enter a period and the name of the subdirectory. 

Make sure the closing bracket is intact. 

5. Check the filename. 

It is not necessary to type the filename unless you want to rename 
the file. 

6. Change the appropriate settings in the Copy dialog box. 

7. Click on OK. 

The Task Output window opens and displays the result of the copy 
operation. 

8. Click on Dismiss to close the Task Output window. 



Review 
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Review the topics covered in this module: 
AooJI a:J.io"S 

• Open a File View window from the etak menu in the Session 
Manager menu bar. 

• File View provides a variety of ways tc> list your files. Using the File 
Filter and a wild card you can list subsets of files. 

• File View provides two commands for displaying files: the 1)rpe 
command for on-screen viewing and the Print command for a paper 
copy. 

• File View provides file maintenance commands. Three of them are 
Copy, Delete, and Purge. 

• A subdirectory is a work area you create under your top level 
directory in which you store files related to a given topic. 

• Use the Navigation List to move up and down (navigate) the 
directory structure. This is how you access your subdirectories and 
the files they contain. 
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Exercise: Using FileView 

1. Choose the commands to display a brief listing and a listing which 
shows all versions of files in your top level directory. What is the 
difference in the number of files displayed? 

2. List the Status.TXT file. 

3. Create a subdirectory called Status. 

4. Copy Status.TXT file to the Status subdirectory. 



Answer 
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1. From the Views menu, choose Brief. Note the number of files 
displayed in the Total Files field. 

From the Views menu, choose Show: AU Versions. Note the 
number of files displayed in the Total Files field. Find the difference. 

2. In the File Filter field, type Status*. Click on Apply. 

3. From the Utilities menu, choose Create Directory. Type Status in 
the Create Directory dialog box. Click on Apply. 

4. Click on Status.TXT to select it. From the Files menu, choose 
Copy. In the Copy dialog box, click the insertion point after the last 
character in the User name in the To field. Type .STATUS. Click on 
OK. 
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4 
Session Manager 

In this module you learn how to: 

• Create a terminal window. 

• Customize a terminal window. 

• Print portions or all of the screen. 

• Capture portions or all of the screen to a file. 

• Customize the DECwindows startup environment. 

4-1 
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Creating a Terminal Window 

l~I DECterm 1 

Command) Edit 

The Session Manager window: 

• Displays on your screen at the start of every DECwindows session. 

• Acts as a control panel for your current session. 

• Displays messages in its Message Region. 

• Ends your DECwindows session. 

You can use the Session Manager window to create a VT320 terminal 
emulation window called DECterm. You can use a DECterm window 
to run applications that otherwise may not be supported in the 
DECwindows environment. You can also use a DECterm window · 
for occasions when you prefer to use a command line interface to the 
system rather than the windowed interface. 

lh!llGi 
Customize Help 

0 .-

'-' 
0 

Figure 4-1 DECterm Window 
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Steps· to Create a Terminal Window 

1. From the Create menu, choose Terminal Window. 

A DECterm window opens. 

2. Give input focus to the window. 
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Customizing a Terminal Window 
Once you have created a DECterm window you can choose tl1e features 
you want the terminal to have. Save these features by using the 
DECterm Customize menu. 

When you save your changes DECterm uses these settings each time you 
create a DECterm window. If you change your mind and want to use 
the settings that came with your system, you can restore the defaults. 

If!] DE. ~rm' .. , ~ . , . . . '·· ... ".:· ... ; llJII] 
,.._,.., I ., .. r I· ~ • ~ : • • ; • • o,F • : .' 

Window •. 

Display ... 

General ... 

Keyboard ... 

7-blt NRCS Selection ... 

Help 

Use Last Saved Settings 

Use Defaults 

Use Saved Settings from ... 

Sava Current Settings 

Save Currant Settings as. .. 

Figure 4-2 DECterm Customize Menu 
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Steps to Customize a Terminal Window 

1. From the Customize menu, choose Window. 

2. Click on the settings you want to change. 

3. Click on Apply or OK. 

4. From the Customize menu, choose Display. 

5. Click on the settings you want to change. 

6. Click on Apply or OK. 

Window 

D Record lines off top 
D Vertical scroll bat· 
D Horizontal sct·oll bat· 
[iJ Vet'tical cm·sor coupling 
D Horizontal cursot· coupling 
0 Auto resize tet·minal 
li1 Auto resize window 

()Big font 

•:i:• Little font 

Terminal size 

I 2~· Rows I el1=" Columns 

()Normal font (80 columns) 

() Condensed font (132 columns) 

(i:• Normal/80, Condensed/132 

OK II I Apply l l Dismiss I 

Figure 4-3 Customize window dialog box 
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Display 

I Auto wt·ap 
I Display ctn·sm· 
I Cm·sor blir1k 

1:i1 Block cm·sm· 

() Undet·lir1e CUt'SOt' 

(!:1 Dat·k text, light backgt·otrnd 
() Light text, dat·k backgt·mmd 

1:;.:1 No status display 

() Host status display 

c::E:J ~ Dismiss 

Figure 4-4 Display Dialog Box 

Steps to Save Customized Settings 

From the Customize menu, choose Save Current Settings. 
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Restoring Default Settings 

If you want to use the settings that came with your system you can 
restore the defaults. 

Steps to Restore Defaults 

From the Customize menu, choose Use Defaults. 

The original settings are restored. 

Exiting from DECterm 

There are two ways to exit from a DECterm window. You may either 
enter the command to log out of your process or choose Quit from the 
Commands menu in the DECterm window. 

Steps to Exit a DECterm Window 

• From the Commands menu, choose Quit. 

The DECterm window closes. 
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Printing and Capturing Screens 

Printing Screens 

DECwindow's print screen feature lets you take a snapshot of an screen 
or a portion of it. You can print the snapshot immediately or capture it 
in a file which can be printed later or included in another file. 

Steps to Print the Entire Screen 

1. Arrange the windows on your screen. 

2. From the Print Screen menu, choose Print Entire Screen. 

The Queue Options dialog box displays. 

By default, the Session Manager formats the captured file for 
PostScript output. 

The print queue to which the file will be sent is highlighted. 

3. Click on the name of the appropriate printer, if necessary. 

4. Click on OK. 

The screen snapshot is written to a file that is deleted after printing. 
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Changing Print Screen Settings 

The default settings used to print a screen immediately may not be the 
correct settings for storing the screen in a file. You can change the 
settings for print screens. 

Customize Pt·int Screen 

Output Format 

1:f.:1 PostSct·ipt 
() Sixel 

() DDIF 

Aspect Ratio 

r.!:1 1 to 1 

02to1 

Ribbon Ot· To11e1· Sa\'et· 

r.!:1 Positi\f e Image 

() Negati\'e ln•age 

Output File Name!,__ U_O_N_E_s_l _______ _ 

il Pt·ompt For File Name 

OK II Apply I Cancel I 

Figure 4-5 Customize Print Screen 
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Steps to Change Print Screen Settings 

1. From the Customize menu, choose Print Screen. 

The Customize Print Screen dialog box displays. 

2. Click on the settings you want to change. 

The Sixel setting enables you to capture a screen that you can 
display in a DECterm window. If you were going to use the file in a 
DECwrite document you would click on DDIF. 

The aspect ratio is 1 to 1, the setting needed to display the file in 
a DECterm window. This is the default setting. The print screen 
aspect ratio allows the snapshot of your screen to be printed without 
distortion on most devices. Some sixel printers require a 2 to 1 
aspect ratio. 

3. Type the name of your top level directory in the Output File Name 
field. 

By default, DECwindows names the output file 
DECW$CAPTURE.TMP. The file is placed in the SYS$LOGIN 
directory, one in which you do not ordinarily store files. 

4. Click on OK. 
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Capturing a Portion of the Screen in a File 

The DECwindows print screen feature also allows you to capture screens 
in a file. 

Steps to Capture a Portion of a Screen in a File 

1. Arrange the screen for easy capture. . 

2. From the Print Screen menu, choose Capture Portion of Screen. 

A dialog box displays. 

By default, the screen will be captured in a file called 
SYS$LOGIN:DECW$CAPTURE.TMP. However, in the Customized 
Print Screen dialog box, you specified the top level directory. 

3. Type the name of the file in which to store the screen shots. 

4. Click OK. 

The pointer changes to a capture cursor, which looks like a plus sign. 

5. Position the capture cursor at the upper left comer of the area you 
want to capture. 

6. Drag the capture cursor until it surrounds the area you want. 

7. Release MBl. 
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Customizing Your DECwindows Environment 
The DECwindows environment comes to you with a host of preset 
options that you can change. You can work successfully with 
DECwindows and never change these options, but by taking advantage 
of these customization features, you can design an environment to fit 
your own working style. 

You can also customize the initial startup screen display. Use Use 
System Defaults if you want to return to the original default settings. 

Customize. Session Manager 

0 
Stat'tup State 

(j:1 Window 

() lcor1 
II Create FileView Window IITJ 
i Confirm Quit Session ........ ------------

Message Regiot1 

10 

Sct'Olled Lit1es Saved 

I Message~· 
Header Text 

Figure 4-6 Customize Session Manager 

Tet'minal Windows 
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Steps to Change the Startup Screen 

1. From the Customize menu, choose Session Manager. 

The Customize Session Manager dialog box displays. 

2. Click on the appropriate settings. 

When you start up next, one DECterm· window will be created. 

3. Click on OK. 

The dialog box disappears. 
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Review Review the topics covered in this module. 

• You can create one or more terminal windows, called DECterms, to 
access host computers. You can change and save settings such as the 

. size of the fonts and the screen display. 

• You can print all or portions of the screen. You can also capture all 
or portions of the screen in a file. 

• You can customize the DECwindows environment. 
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Exercise: Customizing Your Session 

1. Create a DECtenn window. Change the settings to system defaults. 

2. Use the Print Screen option to print your favorite DECwindows 
application. 

3. Delete all files you have created during class. 

4. Return to system defaults for the workstation startup. 

5. Quit DECwindows. 
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Answer 

1. To print the screen of your favorite DECwindows application: 

a. From the Customize menu, choose Print Screen. 

b. Click on PostScript. 

c. Confirm that output File is directed to your top level directory. 

d. Click on OK. 

e. Start your favorite application. 

f. From the Print Screen menu, choose Print Portion of Screen. 

g. Drag the capture cursor to surround the window containing your 
favorite application. 

h. Release MBl. 

i. Click on the name of the appropriate printer listed in the dialog 
box, if necessary. 

J. Click on OK. 

2. To delete all files you have created during class. 

a. In the FileView window Navigation List, click on [.ToDo] to 
enter the subdirectory. 

b. Select and delete all files. 

c. Click on the [-] wild card to return to your top level directory. 

d. From the Navigation List, click on [.Status]. 

e. Delete all files in the subdirectory. 

f. Click on the [-] wild card to return to your top level directory. 

g. Delete all files created during class. 

3. To return to system defaults for workstation startup: 

a. From the Customize menu, choose Use System Defaults. 

b. Click on OK. 
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4. To quit DECwindows: 

a. From the Session menu, choose Quit. 

b. Click on Yes to confirm that you want to save the customized 
settings. 

c. Click on Yes to confirm that you want to quit DECwindows. 
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5 
DECwindows Mail 

In this module you learn how to: 

• Identify the features of DECwindows mail. 

• Create and send a message. 

• Create and use a distribution list to send a message. 

• Read new mail messages. 

• Manage mail messages. 

5-1 
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Overview of DECwindows Mail 
DECwindows mail allows you to correspond with other computer users 
in your workgroup, at other locations, and even around the world. You 
can use Mail to send messages, read messages sent to you, and handle 
your messages. 

Steps to Start DECwindows Mail 

From the Applications menu, choose Mail. 

The main window of DECwindows mail displays. 

File Edit Pick Create-Send Read Maintenance 

~MAIL 

- 5 messages esJ INBOX 

18! 1 8-APR-1990 MIASMA::SMITH 
2 27-APR-1990 SOIREE::JONES 
3 4-MAY-1990 DARCY::BROWN 
4 16-MAY-1990 UDO::WHITE 

18! 
18! 
~ 
~ 5 18-MAY-1990 BRONTE::BLACK 

Ll MAIL 

Ll WASTEBASKET 

~ STATUSREPORTS 

Ll REPORTS 

Ll WASTEBASKET 

Team Meeting, 1:00 
lunch invitation 
RE: review schedule 
poetry reading 
dog class canceled 

~ 0 
I Denver MaH II Read New Mailll Create-Send l~I Forward l~~I Delete I 

Figure 5-1 Main mail window 
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Creating and Sending a Message 
Using Mail you can create and send a message or an existing file to one 
or many users. 

Creating a Message 

Steps to Create a Mail Message 

Click on the Create-Send button in the main window. 

A Create-Send window opens. 

~·JI Mail: Create 

File Edit Change Editor 

lt2::115:1 
Help 

F:cOJfL: useR: rr 
'----------------------~· 

TC•: t'-'-T _________________________ , 

CC: t.__T -------------------------· 

51...1..bject: t'-'-T-------------------------• 

I Quit 11 Reset l l Save As ... l l Send I 

Figure 5-2 Create window 
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Addressing a Mail Message 

Steps to Address a Message 

1. In the To field, enter the usemame of the person to whom you are 
sending the message. 

To send the same message to several users, separate usemames with 
commas. Press IReturnl if you need more space. 

2. Press.ITabl to go forward a field. 

Press lshittl ITabl to go back a field. 

3. Press ITabl to advance to the Subject field. 

The subject is optional. Press IReturnl if you need more space. 

4. Type the title of the message in the Subject field. 

5. Press ITabl to advance to the message area. 

Note that if you are addressing messages to someone on a node other 
than your own, you must enter the person's node and VMS user name in 
the following format: 

Nodename:: Username 

Writing a Message 

DECwindows mail uses the same editor as Notepad. 

Type the message. 
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Saving a Draft of a Message 

By saving a draft of a message, you can continue working on it later. 

Steps to Save a Draft 

1. Click on Save As. 

Mail displays a dialog box. 

Draft: 

Figure 5-3 Draft dialog box 

2. Enter DECwindows a filename for for the draft message. Note: 

Note that you can use up to 39 characters. 

By default, a file extension of .DRAFf is appended automatically to 
the file name and the file is stored in your current" directory. 

3. Click on OK to save the draft message. 

4. Click on Quit to exit the Create window. 
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Resuming Work on a Draft Message 

You can continue working on a draft of a message that you previously 
saved. 

Steps to Resume Work 

1. Click on Create-Send. 

2. Fill in the message header. 

3. From the Create window's File menu, choose Include Draft File. 

A dialog box with a list of draft files displays. 

4. Double click on the appropriate draft file. 

The draft message is displayed in the Create window, where you can 
continue to work on it. 

File Filtet· 

lfSVS$DISK:0*.0RAFT 

Files irl DEVICE:[USER] 

R] D ECW I ND 0 W S .DRAFT; 1 

<:J L I 

Selection 

Figure 5-4 Fiie filter list box 

DC> 

6 
.- Filter I 

OK II 
Cancel I 

._ 
0 

D 
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Sending a Message 

Once you have completed your message you can send it. 

Steps to Send a Message 

1. Click on Send. 

A Mail Send in Progress dialog box displays. It shows the status of 
the message you are sending. 

2. Click on OK to clear the dialog box. 

3. Click on Reset to clear the window without closing it. 

The text in the window is erased, and you can use the window to 
send another message. 
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Sending an Existing File 

In addition to creating a message, you can send a text file you. have 
previously created. 

Steps to ·send an Existing File 

1. Address the message header. 

2. From the Create window's File menu, choose Include File. 

A dialog box appears which lists all files in the current directory and 
prompts you for the name of the file you want to include. 

3. Double click on file you want to send. 

The file is displayed in the message area. You can edit the text. 

4. Click on Send. 

5. Click on Quit. 

The Create window closes. 
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Using A Distribution List 
If you need to send one message to many users, you can create a file, 
called a distribution list, that contains a list of users. 

Creating a Distribution List 

You use an editor, such as Notepad, to create a distribution list. 

Steps to Create a Distribution List 

1. Start Notepad. 

2. Enter one usemame per line. 

3. Save the file using a file extension of .DIS. 

4. Exit Notepad. 
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Sending a Message to a Distribution List 

Practice Text 

Once you have created a distribution list you can use it at any time to 
send mail to these addressees. 

Steps to Send a Message Via a Distribution List 

1. Click on the To field in the envelope area of the Create-Send 
window. 

2. Press MB2. 

A pop-up menu is displayed. 

3. Choose Distribution List. 

Mail displays a dialog box which prompts you for the name of the 
distribution list file you want to use. 

4. Double click on the appropirate distribution list. 

The distribution list name is displayed in the To field. 

5. Enter the remaining message header information. 

6. Enter the message. 

7. Click on Send. 

8. Click on Quit to exit the Create window. 

Our next staff meeting will be held one week from today in the White 
Mountain Conference Room at 10:00. Send your agenda items to me by 
the end of the day. 
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Reading A New Mail Message 
New mail is delivered to the INBOX (or NEWMAIL) folder. When 
you receive new mail, a message is displayed in your Session Manager 
window. 

When you are running mail and you receive new mail, the Deliver 
Mail and Read New Mail buttons in the main window become active. 
However, the new mail messages are not automatically listed. 

Displaying New Messages in the INBOX 

Steps to Display New Messages 

1. Click on Deliver Mail. 

The INBOX folder lists new messages delivered to you while you 
were running mail. 

2. Double click on the message you want to read first. 

DECwindows mail displays the message in a Read window. 

3. Read the message. 

4. Click on Next in the Read window to read the next message. 

5. Click on Close to close a Read window. 

A message you have read stays in the Mail folder until you move it 
to another folder or delete it. 
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!:.:JI Mail: Read-1 [D] MAIL INBOX Hl 

File Edit Create-Send Read 
Date: 22-AUG-1989 17:25:35.68 
F:COJIL: USER1 
Subj: TRAINING 

Tc• : STUDENTS 

The envelope pane at the top of the window displays the name and other address information of the person 
who sent the message. 

I Close 11 Reply 11 Fot·ward ·I I Prit1t 11 Move 11 Delete· I I P{·~~~~iofE 11 Nf~~;:t I 

Figure 5-5 Read window 

Help 
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Mail messages that you have read move from the INBOX into the MAIL 
folder when you exit Mail or use the Update command. The Update 
command automatically deletes and moves any messages so marked 
without your leaving the folder. 

Steps to Update a Folder 

1. Click on the folder name of the folder you want to update. 

The folder name is selected. 

2. Press MB2. 

A pop-up menu appears. 

3. Choose Update folder. 

The folder listing displays 0 messages. 

The messages have been· moved, or updated. 

Opening and Closing Drawers and Folders 

Opening a drawer shows the folders within it. Opening a folder shows 
the list of messages stored in the folder. 

Steps to Open and Close Folders and Drawers 

1. Double click on a folder name to open it. 

The folder opens. DECwindows Mail lists the files within the folder. 

2. Double click on a folder name to close it. 

The files are no longer listed. 

3. Double click on a drawer to either open or close it. 

An open drawer lists the folder within it. 

A closed drawer lists no folders. 
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Managing Mail Messages 
Mail messages accumulate rapidly in the Mail folder. You should 
decide how to handle a mail message as you read it. Dealing with read 
messages is a way of managing your files efficiently. 

Selecting a Message 

Before you work with a message, you must select it. 

To select a message, point to. its listing and click MBl. 

Replying to a Message 

You can reply to a selected message or to the message currently 
displayed in the Read window. 

Steps to Reply to a Message 

1. Select the mail message which you want to answer. 

2. Click on Reply. 

A Create window opens. 

In the To field, Mail inserts the name of the sender of the original 
message. 

In the Subject field, Mail inserts the subject of the original message 
preceded by RE:. 

3. Enter your reply. 

4. Click on Send. 

5. Click on Quit. 



DECwindows Mail 5-15 

Refiling a message 

You may move a message or group of messages from one folder to a 
different folder. 

Steps to Refile a Message 

1. From the main window, double click on the message you want to 
refile. 

This automatically opens a Read window and displays the message. 

2. Click on Move. 

A dialog box displays. 

3. In the Drawer text field, enter the name of the appropriate drawer. 

4. Press ITabl to move to the Folder field. 

5. Enter the appropriate folder name. 

6. Click on OK. 

The index is updated to show that the message has been marked to 
move. 

7. Click on Close. 

Note that until you close the folder which held the message originally 
the message will not be moved. 

8. Close the folder (by double clicking on its folder name) which 
contains the message you have marked to move 

Once the folder is closed, the message is refiled. 
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Deleting a Message 

The MAIL drawer can become cluttered with messages. 

You must decide which messages to keep and which to delete. 

Steps to Delete Mail Messages 

1. Select the messages you want to delete. 

2. Click on Delete. 

The index is updated to show the message has been marked for 
deletion. 

3. Close the folder which stores the deleted message. 

Once the folder is closed, deleted messages are moved to the 
WASTEBASKET folder. 
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Emptying the Wastebasket 

Deleted messages collect in the WASTEBASKET folder until you exit 
mail or deliberately empty the WASTEBASKET. 

Note that through the Modify Mail Profile dialog box (Customize menu), 
there is a setting which can be toggled on to empty the WASTEBASKET 
automatically upon closing a drawer. 

Steps to Empty the WASTEBASKET 

1. Click on WASTEBASKET. 

2. From the main window, pull down the Maintenance menu. 

3. Select Empty Wastebasket. 

4. Double click on the drawer name to close the drawer. 

Once the WASTEBASKET is emptied, the deleted messages are 
irretrievable. 
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Review Review the topics covered in. this module: 

• DECwindows mail allows you to exchange messages with other 
computer users. 

• You can create and send a mail message or an existing file to one or 
many users. 

• If you need to send one message to many users, create a file called 
a distribution list that contains a list of users. You then specify an 
at sign (@) and the file name in the To field when you send the 
message; for example, @CLASS. 

• New mail messages are automatically listed in the INBOX folder; 
unread messages are identified by an icon resembling an addressed 
envelope. 

• You maintain mail messages in several ways: by printing, deleting, 
and refiling. 
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Exercise: DECwindows Mail 

1. Enter DECwindows mail. 

2. Create and send a mail message to the instructor. In it express your 
opinion of the class. 

3. Create and send a message using the CLASS.DIS distribution list. In 
the message, send agenda items for a staff meeting. 

4. Read any new mail messages you have received. 

5. Open each folder in your account and delete the messages within the 
folder. 

6. Empty the wastebasket. 

7. Quit DECwindows mail. 
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Answer 

1. To enter DECwindows Mail, point to the Applications menu in the 
File View window. Choose Mail. 

2. To create and send a message: 

a. From the Main menu, click on Create-Send. 

b. In the To field, enter the username of your instructor. 

c. Press ITabl to move to the Subject field and enter a subject such 
as Opinion. 

d. Press ITabl to move to the message area. 

e. Type the message expressing your opinion of the class. 

f. Click on Send. 

3. To create and send a message using the CLASS .DIS distribution list, 

a. Press Reset to clear the window without closing it. 

b. In the To field, enter @CLASS. 

c. Press ITabl to move to the Subject field and enter Agenda Items. 

d. Press ITabl to move to the message area. 

e. List the agenda items for a staff meeting. 

f. Click on Send. 

g. Close the Create window. 

4. To read new mail: 

1. From the Main menu, click on Deliver Mail. 

2. Click on the mail message you want to read. 

3. After you read the message, click on Next to read the next 
message. 

4. When you have finished reading mail messages, click on Close 
to exit the Read window. 



DECwindows Mail 5-21 

5. To open each folder and delete the messages within the folder: 

a. From the main Menu, double click on each folder to open the 
folder. 

b. Click on the first file. 

c. Shift click on each succeeding file .. 

d. Click on the Delete button. 

6. To empty the WASTEBASKET: 

a. Double click on a folder name to close the folder. 

b. Double click on a drawer name to close the drawer. 

c. From the Main window's Maintenance menu, choose Empty 
Wastebasket. 

7. To quit DECwindows mail, choose Exit from the File menu in the 
Main Mail window. 





Objectives In this module you learn how to: 

• Identify the features of DECpaint. 

• Create graphics. 

• Enhance graphics. 

• Insert text in a graphic. 

• Save and print DECpaint files. 

6 
DECpaint 

• Send and receive DECpaint files through DECwindows mail. 

6-1 
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Overview of DECpaint 

~I J'aint: 

DECpaint is a graphics program that lets you create any kind of simple 
picture, such as a sketch, an illustration, or a map. From an assortment 
of art tools, you can draw freehand or pick shapes from a menu. You 
can then enhance the picture by selecting fill patterns to shade or "color" 
your picture. 

Steps to Start Paint 

Choose Paint from File View's Application window. 
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Figure 6-1 DECpalnt window 



DECpaint 6-3 

Creating Graphics 
Only one tool on the tool palette is active at a time. The tool remains 
active until you make another selection. 

Steps to use the DECpaint Tools 

1. Click on the DECpaint tool that you wish to use. 

2. Point to the canvas. 

3. Hold down MBl and drag the pointer. 

4. ·Release MBl to stop using the DECpaint tool. 

Drawing Lines and Shapes 

The bottom half of the tool palette contains a collection of lines and 
shape tools. 

Steps to Draw a Rectangle 

1. Click on Rectangle. 

2. Position the pointer in the drawing window where you want one 
comer of the rectangle to be. 

3. Press MBl and drag the pointer diagonally across the drawing 
surface until the rectangle has the desired width and height. 

4. Release MBl to anchor the shape. 

The rectangle is filled with solid black, the default setting. 
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Enhancing graphics 
DECpaint's electronic canvas enables you to easily enhance your 
drawings. You can delete images entirely or you can change the line 
width and fill pattern of existing images. 

Selecting an Area of the Canvas 

You need to select all or portions of a graphic before making changes 
or enhancing it. There are two selection tools to mark a portion of the 
window for a graphics operation. 

• The Selection Box tool is used to select a rectangular area. 

• The Scissors to select an irregular area. 

Steps to Select a Portion of a Drawing Window 

1. Click on the Selection Box tool. 

2. Point to one comer of the area you want to erase. 

3. Drag MBl to the opposite comer of the area. 

4. Release MBl. 

A rectangle on the screen surrounds the selected area. 

Steps to Clear a Selected Area 

1. Move the pointer inside the selected area. 

2. From the Edit menu, choose Clear. 

Steps to Cut Out an Irregular Portion of the Screen 

1. Click on the Scissors tool. 

2. Drag the pointer around a different area of the canvas, outlining an 
irregular portion of the drawing. 

3. From the Edit menu, choose Clear. 
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Selecting the Entire Canvas 

Using Patterns 

Steps to Erase an Entire Drawing 

1. From the Edit menu, choose the Select All menu item. 

2. From the Edit menu, choose Clear. 

In addition to producing solid lines and objects with the default settings, 
you can also draw using striped, speckled, woven, and dotted lines and 
shapes. 

The line and shape tools, the Spray Can, and the Paintbrush can paint 
patterned lines and borders. The default outline is solid. 

Changing the Borders 

You can change the solid black border, or outline, of a figure by 
choosing a different type of border from the Patterns dialog box. 

Steps to Display the Patterns Dialog Box 

From the Options menu, choose Patterns. 

Steps to Change the Border 

1. Click on the Border button. 

2. Click on a pattern. 

3. Position the pointer in the drawing window. 

4. Drag the pointer to create a figure with a patterned. border. 

5. Release MBl. 
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Changing the Fill 

• D I None 

II Dismiss II 

Figure 6-2 Patterns palette dlalog box 

You can change the interior of a shape by using the Patterns Dialog box. 
In addition to a variety of patterns, you can choose a solid white or a 
transparent interior. The transparent interior is labeled "None." 

Steps to Fill Shapes 

1. From the Options· menu, choose Patterns. 

2. Click on the Fill Pattern button. 

Note the border of the Fill Pattern button becomes bolded. 

3. Click on any pattern in the palette. 

The pattern you choose displays in the interior of the Fill Pattern 
button. When you draw a shape, it will be filled with the same 
pattern as the Fill Pattern button. 

4. Click on the shape to be filled. 
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5. Position the pointer in the drawing window, and drag the pointer to 
create the shape. 

Using the Paint Bucket 

Another way to add a pattern to your drawing is to use the Paint Bucket 
tool. 

You can fill existing shapes with the Paint Bucket tool by clicking MBl 
inside the shape you want to fill. The shape must be enclosed; any 
opening in the border causes the paint to spill out onto the canvas. 

You can reverse filling a shape by choosing Undo Flood from the Edit 
menu. 

Steps to Use the Paint Bucket Tool 

1. In the Patterns dialog box, click on a new pattern. 

2. Click on the Paint Bucket. 

3. Point to the shape and click MBl. 
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Changing Brush Shapes 

You can change the shape of the tip of the Paintbrush. 

• a • II • 
.fl • • - e 
.. ··· ......... · .... ········• ...... ··•·•·····• ................... ·· 

·· ... ·•· ....... "········ ..• "······· ........ --~--

II Dismiss II 

Figure 6-3 Brush shapes dialog box 

Steps to Change the Shape of the Paintbrush Tip 

1. Click on the Paintbrush. 

2. From the Options menu, choose Brush Shapes. 

A dialog box displays. 

3. Click on the brush shape you want. 



Varying Line Width 

You can vary the thickness of a line. 

Dismiss 

Figure 6-4 Line width dialog box 

Steps to Change Line Width 

1. From the Options menu, choose Line Width. 

2. Click on the line thickness you want. 
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Inserting Text in a Graphic 
You can insert text anywhere in the Paint window, and you can change 
the appearance of the text by using different fonts, sizes, and styles of 
type. 

Steps to Insert Text 

1. From the tool pallette, select the Text tool, the letter "A." 

2. Position the pointer in the Paint window where you want to insert 
text and click MBl. 

3. Type the text. 

Modifying the Appearance of Text 

Until the moment you click to complete the text entry, you can change 
the appearance of text. After that, Paint incorporates the text into the 
graphic image. 

Steps to Change the Appearance of Text 

1. From the Font menu, slide right on the submenu icon next to Family. 

The submenri appears and lists three choices: Courier, Times, and 
Helvetica. 

2. Release MBl over the family you want. 

3. From the Font menu, slide right on the submenu icon next to Style. 

The submenu appears and lists three choices: Normal, Italic, and 
Bold. 

4. Release MBl over the style you want. 

5. From the Font menu, slide right on the submenu icon next to Size. 

The submenu appears and lists five point sizes: 10, 12, 14, 18, and 
24 picas. 

6. Release MBl over the pica size you want. 
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Saving and Printing DECpaint Files 

Saving a Painting 

You can save your pictures for later use and print them on different 
kinds of printers. 

Steps to Save a Painting 

1. From the File menu, choose Save As. 

2. Type. a filename. 

All paint files are given a .DDIF file type. 

3. Click on OK. 

Printing a Painting 

DECpaint supports printing to both PostScript printers and sixel printers 
such as the LASO and LAlOO. When printing on an LASO printer, set an 
aspect ratio of 2: 1. All other printers have a 1: 1 aspect ratio. 

The File menu provides two menu items for printing a DECpaint file: 

• Print sends the painting to the default printer. 

• Print... displays the print dialog box. 
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Sending and Receiving DECpaint Files through 
DECwindows Mail 

You can use DECwindows mail to send and receive files created in 
DECpaint. 

Steps to Mail a Paint File 

1. Start DECwindows mail. 

2. From the menu bar in the main mail window, pull down the 
Create-Send menu. 

3. Choose File and slide right on the submenu icon. 

A submenu appears. 

4. Choose No editor. 

A dialog box appears and lists all files in the current directory. · 

5. Type *.DDJF in the file filter and click on Filter. 

6. Double.click on the .DDIF file you created in Paint. 

The create window opens. 

Note that in the menu bar, the Change Editor option is not active. 
In the message area, the following note displays within parentheses: 

This message type cannot currently be displayed. 

7. Address the message to the student on your right. 

8. Click on Send. 
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Receiving a Paint file through DECwindows Mail 

When you receive a paint file in DECwindows mail you can extract and 
place it in the paint window to view and edit it. 

Steps to Receive a Paint File 

1. In the main Mail window, click on Deliver Mail. 

The list of new mail messages displays. 

2. Click on the file containing the paint file. 

The file is selected. 

3. From the File menu, choose Extract. 

The Extracting Selected Messages dialog box appears. 

4. Click on Include Header Information to toggle off. 

5. In the File text field, type a filename and extension. 

6. Start DECpaint. 

7. From the File menu, choose Open. 

The Open dialog box displays. It lists all .DDIF files. You can use 
the file filter to display other appropriate file types such as .IMG. 

8. Type *·™Gin the File Filter field and click Filter. 

9. Click on the image file you want. 
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Review Review the topics covered in the module: 

• DECpaint is a graphics program that lets you create simple pictures. 

• You create drawings by using tools and shapes from the Tool Palette. 

• You enhance the drawing by selecting different fill patterns, line 
widths and brush shapes. You can erase a portion or an entire 
drawing. 

• You enter text by choosing the text tool from the Tool Palette. The 
text family, size, and style can be changed. 

• DECpaint files have a .DDIF file type. You can save and print a 
paint file. 

• DECwindows mail allows you to send and receive Paint files. 
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DECpaint Exercise 

1. Start DECpaint. 

2. Create a diagram of your office. 

3. Save the file. 
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Answer 

1. To start DECpaint, from FileView's Application menu, choose Paint. 

2. Use the tool palette to create a drawing. 

3. To save the file, from the File menu, choose Save As. Enter a file 
name in the dialog box and click on OK. 


